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Paper Set 1 · 04 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଏକ ସ୍ତମ୍ଭର ଉଚ୍ଚତା 64 ମି ଟର ଅଟେ । ଯେତେବେଳେ ସୂ ର୍ଯ୍ୟ ଙ୍କ ଉଚ୍ଚତାର କୋଣ 45° ହୁ ଏ,
ସେତେବେଳେ ଏହା ଛାୟାର ଦୈ ର୍ଘ୍ୟ  କେତେ ହେବ?

A.  32 m

B.  64 m

C.  128 m

D.  21 m

✓

Q2 Quant
ସ୍ଥି ର ପାଣି ରେ ଡଙ୍ଗାର ବେଗ 18 km/hr ଅଟେ । ଯଦି  ସ୍ରୋ ତର ବେଗ 2 km/hr ହୁ ଏ,
ତେବେ ଡଙ୍ଗାଟି  ସ୍ରୋ ତର ପ୍ର ତି କୂ ଳରେ 32 km ଅତି କ୍ର ମ କରି ବା ପାଇଁ  କେତେ ସମୟ ନେବ?

A.  1.5 ଘଣ୍ଟା

B.  2 ଘଣ୍ଟା

C.  2.5 ଘଣ୍ଟା

D.  3 ଘଣ୍ଟା

✓

Q3 Quant
ଜଣେ ଦୋକାନୀ ₹200 ରେ ଗୋଟି ଏ ଖେଳଣା କି ଣି  ₹250 ରେ ବି କ୍ରି   କରନ୍ତି  । ତାଙ୍କର ଲାଭ
ପ୍ର ତି ଶତ କେତେ?

A.  20%

B.  25%

C.  30%

D.  35%

✓

Q4 Quant
A bus goes from Jaipur to Kota at 60 km/hr and returns at 90 km/hr.
Find the average speed for the entire journey.

A.  72 km/hr

B.  75 km/hr

C.  54 km/hr

D.  60 km/hr

✓

Q5 Quant
P ଓ Q ଯଥାକ୍ର ମେ ₹60,000 ଏବଂ ₹40,000 ସହି ତ ଏକ ଭାଗି ଦାରୀ ବ୍ୟବସାୟ ଆରମ୍ଭ
କରନ୍ତି  । 3 ମାସ ପରେ Q ତାଙ୍କର ତାଙ୍କ ପୁ ଞ୍ଜି ର ଅଧା ଅର୍ଥ  ଉଠାଇ ନେଲେ । ତା’ର ପୁ ନଶ୍ଚ 4.5
ମାସ ପରେ, P ଆଉ ₹30,000 ଯୋଗ କରନ୍ତି , ଏବଂ Q ଉଠାଇ ନେଇଥି ବା ଅର୍ଥ  ସହି ତ
ଅତି ରି କ୍ତ ₹10,000 ପୁ ନଃନି ବେଶ କଲେ । ଯଦି  ବ୍ୟବସାୟର ମୋଟ ଅବଧି  10 ମାସ ହୁ ଏ,
ତେବେ ସେହି  କ୍ର ମରେ P ଓ Q ର ଚୂ ଡ଼ାନ୍ତ ଲାଭ ବଣ୍ଟନର ଅନୁ ପାତ କେତେ ହେବ?

A.  67:135

B.  135:67

C.  145:68

D.  155:67

✓

Q6 Quant
ଅରୁ ଣ ₹12,600 ନି ବେଶ କରି  ଏକ ବ୍ୟବସାୟ ଆରମ୍ଭ କରି ଥି ଲେ ଏବଂ କି ଛି  ମାସ ପରେ
ତରୁ ଣ ₹25,200 ନି ବେଶ କରି  ବ୍ୟବସାୟରେ ଯୋଗ ଦେଇଥି ଲେ । ଏକ ବର୍ଷ  ଶେଷରେ
ମୋଟ ₹8,905 ଲାଭ ହୋଇଥି ଲା, ଯେଉଁ ଥି ରେ ଅରୁ ଣଙ୍କ ଅଂଶ ₹3,562 ଥି ଲା । ତରୁ ଣ
କେତେ ମାସ ପାଇଁ  ବ୍ୟବସାୟରେ ଯୋଗ ଦେଇଥି ଲେ?

A.  6

B.  8

C.  9

D.  10

✓

Q7 Quant
ମୋହି ତ 15 ଦି ନରେ ଗୋଟି ଏ କାର୍ଯ୍ୟ  ଶେଷ କରି ପାରି ବେ ଏବଂ ରୋହି ତ 30 ଦି ନରେ ସମାନ
କାର୍ଯ୍ୟ  ଶେଷ କରି ପାରି ବେ । ସେମାନେ ଏକାଠି  କାମ କରନ୍ତି  ଏବଂ କାମ ପାଇଁ  ମୋଟ ₹4,500
ରୋଜଗାର କରନ୍ତି  । ସେମାନଙ୍କ ଯୋଗଦାନ ଆଧାରରେ ମୋହି ତ ମୋଟ ଦେୟରୁ  କେତେ
ପାଇବା ଉଚି ତ?

A.  ₹1,500

B.  ₹2,000

C.  ₹2,500

D.  ₹3,000

✓

Q8 Quant
ବାକ୍ସ X ଓ ବାକ୍ସ Y ରେ ଥି ବା ବୋତଲ ସଂଖ୍ୟାର ଅନୁ ପାତ ଯଥାକ୍ର ମେ 6 : 5 ଅଟେ । ଯଦି  ବାକ୍ସ
Y ରୁ  6 ଟି  ବୋତଲ ବାକ୍ସ X କୁ  ସ୍ଥାନାନ୍ତର କରାଯାଏ, ତେବେ ଉଭୟ ବାକ୍ସରେ ଥି ବା ବୋତଲ
ସଂଖ୍ୟାର ଅନୁ ପାତ ଯଥାକ୍ର ମେ 4 : 3 ହୁ ଏ । ପ୍ରା ରମ୍ଭରେ ବାକ୍ସ X ରେ ଥି ବା ବୋତଲ ସଂଖ୍ୟା
ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

A.  72

B.  84

C.  102

D.  126

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q9 Quant
ଯଦି  ଏକ ମଧ୍ୟମ ବି ଷମ ବି ତରଣର ମାଧ୍ୟମାନ ଏବଂ ମଧ୍ୟମା ଯଥାକ୍ର ମେ 25 ଏବଂ 30 ହୁ ଏ,
ତେବେ ଏହାର ଗରି ଷ୍ଠକ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  35

B.  38

C.  40

D.  45

✓

Q10 Quant
If 20% of a number is added to 42, then the result is the same
number. 80% of the same number is:

A.  42

B.  52

C.  72

D.  62

✓

Q11 Quant
ବାର୍ଷିକ 5% ସରଳ ସୁ ଧ ହାରରେ 5 ବର୍ଷ ରେ କେତେ ମୂ ଳଧନ (₹ ରେ) ର ସମୂ ଳସୁ ଧ
₹4,800 ହେବ?

A.  3,840

B.  3,790

C.  3,890

D.  19,200

✓

Q12 Quant
ପ୍ର ବୀଣଙ୍କ ପାଖରେ ₹1302 ଅଛି  । ସେ ଏହାକୁ  ତାଙ୍କ ପୁ ଅ ରି ଷି  ଓ ଶାନଙ୍କ ମଧ୍ୟରେ ବାଣ୍ଟି
ଦେଲେ ଏବଂ ସେମାନଙ୍କୁ  ବାର୍ଷିକ 10% ସୁ ଧ ହାରରେ ନି ବେଶ କରି ବାକୁ  କହି ଲେ, ଯାହା
ବାର୍ଷିକ ଚକ୍ର ବୃ ଦ୍ଧି  ହେବ । ଏହା ଦେଖାଗଲା ଯେ ରି ଷି  ଓ ଶାନଙ୍କ ପାଖରେ ଯଥାକ୍ର ମେ 13 ଓ
14 ବର୍ଷ  ପରେ ସମାନ ରାଶି  ଅଛି  । ପ୍ର ବୀଣ ଶାନଙ୍କୁ  କେତେ (₹ ରେ) ଦେଇଥି ଲେ?

A.  620

B.  682

C.  470

D.  782

✓

Q13 Quant
ମନେକର C ଏକ ବୃ ତ୍ତ ଯାହାର କେନ୍ଦ୍ର O ଏବଂ PQ ଏହାର ଏକ କ୍ଷୁ ଦ୍ର  ଚାପ ଅଟେ ।
ମନେକର S, PQ ଚାପ ଉପରି ସ୍ଥ ଏକ ବି ନ୍ଦୁ  ଏବଂ R, C ବୃ ତ୍ତର ଅବଶି ଷ୍ଟ ଚାପ PQ ଉପରି ସ୍ଥ
ଏକ ବି ନ୍ଦୁ  ଅଟେ । ଯଦି  PQ ଜ୍ୟା କେନ୍ଦ୍ର O ଠାରେ 106° ର ଏକ କୋଣ ଉତ୍ପନ୍ନ କରେ,
ତେବେ ∠PSQ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  106°

B.  60°

C.  127°

D.  120°

✓

Q14 Quant
ଗୋଟି ଏ ସଂଖ୍ୟାକୁ  60% ବୃ ଦ୍ଧି  କଲେ 3880 ହୁ ଏ । ସଂଖ୍ୟାଟି  କେତେ?

A.  2425

B.  2850

C.  1212

D.  1727

✓

Q15 Quant
ଗୋଟି ଏ ପାଇପ ଟାଙ୍କି କୁ  6 ମି ନି ଟରେ ଭର୍ତ୍ତି କରି ପାରେ, ଯେତେବେଳେ କି  ଅନ୍ୟ ଏକ
ପାଇପ ଭର୍ତ୍ତି ଟାଙ୍କି କୁ  7 ମି ନି ଟରେ ଖାଲି  କରି ପାରେ । ଯଦି  ଟାଙ୍କି ଟି  ଖାଲି  ଥି ବାବେଳେ
ଉଭୟ ପାଇପକୁ  ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ର ଅଧା ଅଂଶ ଭର୍ତ୍ତି ହେବା ପାଇଁ
କେତେ ସମୟ (ମି ନି ଟରେ) ଲାଗି ବ?

A.  21

B.  22

C.  42

D.  43

✓

Q16 Quant
The product of two consecutive positive integers is 506. If the
smaller of these two integers is represented by x, which of the
options below will correspond to the equation for finding out the
value of x?

A.  x2 + x - 506 = 0

B.  x2 + x + 506 = 0

C.  x2 - x - 506 = 0

D.  x2 - x + 506 = 0

✓

Q17 Quant
An article has a cost price of ₹394 and is marked at ₹1,182. If the
seller offers a 50% discount on the marked price, what will be his
profit percentage?

A.  50%

B.  49%

C.  48%

D.  51%
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✓

Q18 Quant
ର ଲ.ସା.ଗୁ . କେତେ?

A.  

B.  

C.  

D.  

✓

Q19 Quant

 ସରଳ କର ।

A.  14.61

B.  10.11

C.  12.98

D.  10.13

✓

Q20 Quant
ଯଦି ହୁ ଏ ତେବେର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
ନି ମ୍ନ ଲି ଖି ତ ଭାରତୀୟ ମହି ଳା ବକ୍ସରଙ୍କ ମଧ୍ୟରୁ  କି ଏ ଜୁ ଲାଇ 2025 ରେ ଅନୁ ଷ୍ଠି ତ ବି ଶ୍ୱ ବକ୍ସିଂ
କପରେ ସ୍ୱର୍ଣ୍ଣ  ପଦକ ଜି ତି  ନଥି ଲେ?

A.  ସାକ୍ଷୀ ଚୌଧୁ ରୀ 

B.  ନୁ ପୁ ର ଶେଓରାନ 

C.  ଜାସମି ନ୍  ଲାମ୍ବୋରି ଆ

D.  ମୀନାକ୍ଷୀ

✓

Q22 GA
ମାନବ-ହାତୀ ସଂଘର୍ଷ ର ବୃ ଦ୍ଧି  ପାଉଥି ବା ସଂଖ୍ୟାକୁ  ରୋକି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ
ରାଜ୍ୟ ‘ଗଜ ମି ତ୍ର ’ ଯୋଜନା ଆରମ୍ଭ କରି ଛି ?

A.  ଆସାମ

B.  ମେଘାଳୟ

C.  କେରଳ

D.  ଉତ୍ତରାଖଣ୍ଡ

✓

Q23 GA
Which of the following is NOT an intrusive volcanic landform?

A.  Sill

B.  Batholith

C.  Dyke

D.  Caldera

✓

Q24 GA
ଓଡ଼ି ଶାର ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଜି ଲ୍ଲାରେ ବେଦାନ୍ତ ଆଲୁ ମି ନା ରି ଫାଇନାରୀ ଅବସ୍ଥି ତ?

A.  ଅନୁ ଗୁ ଳ 

B.  କୋରାପୁ ଟ

C.  କଳାହାଣ୍ଡି

D.  ରାୟଗଡା

✓

Q25 GA
2025 ମସି ହା ଜୁ ଲାଇ ମାସରେ ଘାନା ଗସ୍ତ ସମୟରେ, ପ୍ର ଧାନମନ୍ତ୍ରୀ ନରେନ୍ଦ୍ର ମୋଦୀ
କଟକର ଏକ ହସ୍ତନି ର୍ମିତ ରୂ ପା ତାରକସି  ପର୍ସ  ପ୍ର ଥମ ମହି ଳା ଲୋର୍ଡିନା ମହାମା
(Lordina Mahama) ଙ୍କୁ  ଉପହାର ଦେଇଥି ଲେ । ଏହି  ଉପହାରଟି  ଓଡ଼ି ଶାର କେଉଁ
ପାରମ୍ପରି କ ହସ୍ତଶି ଳ୍ପକୁ  ପ୍ର ତି ନି ଧି ତ୍ୱ କରେ?

A.  ଚାନ୍ଦୁ ଆ କଳା

B.  ତାରକସି

C.  ଲାଖ କାମ

D.  ଝୋଟି  ଚି ତା

✓

Q26 GA
ପଶ୍ଚି ମ ଓଡ଼ି ଶାରେ ବନ୍ୟା ନି ୟନ୍ତ୍ରଣ, ଜଳସେଚନ ଏବଂ ବି ଦ୍ୟୁ ତ ଉତ୍ପାଦନର ମୁ ଖ୍ୟ ଆଧାର,
ମହାନଦୀ ଉପରେ ଅବସ୍ଥି ତ ହୀରାକୁ ଦ ବନ୍ଧକୁ  କେବେ ଆନୁ ଷ୍ଠାନି କ ଭାବେ ଉଦଘାଟନ
କରାଯାଇଥି ଲା?

A.  1953

B.  1955

C.  1957

D.  1959

✓

Q27 GA
ରାଜ୍ୟରେ ବୃ ତ୍ତି ଗତ ଟି କସ ଆଦାୟକୁ  ଓଡ଼ି ଶା ସରକାର 2026 ମସି ହାରେ କେଉଁ  ଆଇନଗତ
ପଦକ୍ଷେପ ମାଧ୍ୟମରେ ରଦ୍ଦ କରି ଥି ଲେ?

A.  ଓଡ଼ି ଶା ଦ୍ର ବ୍ୟ ଏବଂ ସେବା କର (ସଂଶୋଧନ) ଅଧି ନି ୟମ, 2026

B.  ଓଡ଼ି ଶା ରାଜ୍ୟ ବୃ ତ୍ତି , ବାଣି ଜ୍ୟ, ଆଜୀବି କା ଏବଂ ନି ଯୁ କ୍ତି  ଟି କସ (ଉଚ୍ଛେଦ)
ଅଧ୍ୟାଦେଶ, 2026

C.  ଓଡ଼ି ଶା ନି ଯୁ କ୍ତି  ଓ ଶ୍ର ମ କଲ୍ୟାଣ ଆଇନ, 2026

D.  ଓଡ଼ି ଶା ଆର୍ଥିକ ଦାୟି ତ୍ୱ ସଂଶୋଧନ ଆଇନ, 2026

✓

Q28 GA
ସେଣ୍ଡାଇ ଫ୍ରେ ମୱାର୍କ  (2015–2030) ର ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ କ’ଣ ଅଟେ?

A.  ମହାକାଶ ପ୍ର ଯୁ କ୍ତି ବି ଦ୍ୟାର ଉନ୍ନତି  

B.  ବି ପର୍ଯ୍ୟ ୟ ଆଶଙ୍କା ହ୍ରା ସ କରି ବା

C.  ବି ଶ୍ୱ ବାଣି ଜ୍ୟ ବି କାଶ

D.  ବର୍ଦ୍ଧିତ ଶି ଳ୍ପାୟନ

✓

Q29 GA
କେଉଁ  ଭାରତୀୟ ବି ପ୍ଳବୀ ଏବଂ ସ୍ୱାଧୀନତା ସଂଗ୍ରା ମୀ 1857-1858 ମସି ହାରେ ଝାଡ଼ଖଣ୍ଡର
ସିଂ ହଭୂ ମି  ଜି ଲ୍ଲାର ବାର୍  ପି ର୍  (Bar Pir) ଅଞ୍ଚଳର ଆଦି ବାସୀ ସମ୍ପ୍ରଦାୟର ନେତୃ ତ୍ୱ
ନେଇଥି ଲେ ?

A.  ଗୋନୁ  (Gonoo)

B.  ଶାହା ମଲ (Shah Mal)

C.  ସି ଦ୍ଧୁ  ମୁ ର୍ମୁ

D.  ତାନ୍ତି ଆ ଭି ଲ

✓

Q30 GA
2025 ରାଜ୍ୟ ନି ର୍ବା ଚନ ପରେ ବି ହାରର ମୁ ଖ୍ୟମନ୍ତ୍ରୀ ଭାବେ କି ଏ ଶପଥ ଗ୍ର ହଣ କରି ଥି ଲେ?

A.  ନି ତୀଶ କୁ ମାର

B.  ନୀରଜ ଶର୍ମା

C.  ଅନି ଲ ମେହେତା

D.  ସୁ ଧୀର ଯାଦବ
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✓

Q31 GA
ଅକ୍ଟୋବର 2025 ରେ ଆନୁ ଷ୍ଠାନି କ ଭାବେ ଘୋଷଣା କରାଯାଇଥି ବା ଅନୁ ଯାୟୀ କେଉଁ
ଫୁ ଟବଲଖେଳାଳୀଙ୍କୁ  'ବ୍ୟାଲନ ଡି 'ଅର୍ ' (Ballon d'Or) 2025 ପ୍ର ଦାନ କରାଯାଇଥି ଲା?

A.  କାଇଲି ଆନ୍  ଏମବାପେ (Kylian Mbappé)

B.  ଏର୍ଲିଙ୍ଗ ହାଲାଣ୍ଡ (Erling Haaland)

C.  ଜୁ ଡ୍  ବେଲିଂ ହାମ୍  (Jude Bellingham)

D.  ଓସମାନ ଡେମ୍ବେଲେ (Ousmane Dembélé)

✓

Q32 GA
କୋଷ ଜୀବକର ଝି ଲ୍ଲୀରେ ପ୍ରୋ ଟି ନ କାହିଁକି  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଟେ?

A.  ସେଗୁ ଡି କ ପରି ବହନ ଏବଂ ଯୋଗାଯୋଗକୁ  ସୁ ଗମ କରନ୍ତି

B.  ସେଗୁ ଡି କ ଆନୁ ବଂଶି କ ସୂ ଚନା ସଂରକ୍ଷଣ କରନ୍ତି

C.  ସେଗୁ ଡି କ ଗ୍ଲୁ କୋଜ ଉତ୍ପାଦନ କରନ୍ତି

D.  ସେଗୁ ଡି କ ରାଇବୋଜୋମ ଗଠନ କରନ୍ତି

✓

Q33 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତର ବି ଭି ନ୍ନ ଅଞ୍ଚଳରେ ହି ମାଳୟର ସ୍ଥି ତି  (alignment) କୁ
ବର୍ଣ୍ଣ ନା କରେ?

A.  ସମଗ୍ର  ହି ମାଳୟ ଅଞ୍ଚଳରେ ସ୍ଥି ତି  (alignment) ସର୍ବ ଦା ସ୍ଥି ର ରହି ଥାଏ

B.  ଭାରତର ବି ଭି ନ୍ନ ଅଞ୍ଚଳରେ ସ୍ଥି ତି  ପରି ବର୍ତ୍ତ ନ ହୋଇଥାଏ

C.  ସ୍ଥି ତି  କେବଳ ଉତ୍ତର-ଦକ୍ଷି ଣ ଦି ଗ ପର୍ଯ୍ୟ ନ୍ତ ସୀମି ତ ଅଟେ

D.  ସ୍ଥି ତି  କେବଳ ପୂ ର୍ବ -ପଶ୍ଚି ମ ଦି ଗ ପର୍ଯ୍ୟ ନ୍ତ ସୀମି ତ ଅଟେ

✓

Q34 GA
'ଉଦ୍ଦେଶ୍ୟମୂ ଳକ ସଂକଳ୍ପ (Objectives Resolution)' ପରି ଶେଷରେ ଭାରତୀୟ
ସମ୍ବି ଧାନର କେଉଁ  ଅଂଶର ରୂ ପ ନେଇଥି ଲା?

A.  ପ୍ର ସ୍ତାବନା

B.  ନି ର୍ଦ୍ଦେ ଶକ ନୀତି

C.  ନାଗରି କତା ବ୍ୟବସ୍ଥା

D.  ମୌଳି କ ଅଧି କାର

✓

Q35 GA
Which of the following is the highest sporting honour in India, given
for the most outstanding performance by a sportsperson over a
period of four years?

A.  Arjuna Award

B.  Dronacharya Award

C.  Major Dhyan Chand Khel Ratna Award

D.  Indira Gandhi Khel Ratna Award

✓

Q36 GA
ଗୋଟି ଏ ସଳଖ ପରି ବାହୀ ଚାରି ପଟେ ଥି ବା ଚୁ ମ୍ବକୀୟ କ୍ଷେତ୍ର ର ଶୈ ଳୀ ନି ର୍ଣ୍ଣ ୟ କରି ବା ପାଇଁ
ଜଣେ ବି ଦ୍ୟାର୍ଥୀ  ଏକ କମ୍ପାସ ବ୍ୟବହାର କରନ୍ତି  । ଯଦି  ବି ଦ୍ୟୁ ତ ସ୍ରୋ ତକୁ  ଦୁ ଇଗୁ ଣ କରାଯାଏ,
ତେବେ କମ୍ପାସ ସୂ ଚୀରେ ବି ଚ୍ୟୁ ତି ରେ କି  ପରି ବର୍ତ୍ତ ନ ପରି ଲକ୍ଷି ତ ହେବ?

A.  କମ୍ପାସ ସୂ ଚୀ କୌଣସି  ବି କ୍ଷେପ ଦେଖାଏ ନାହିଁ ।

B.  କମ୍ପାସ ସୂ ଚୀରେ ବି କ୍ଷେପ ଅନି ୟମି ତ ଭାବରେ ପରି ବର୍ତ୍ତ ନ ହେବ ।

C.  କମ୍ପାସ ସୂ ଚୀ ପୂ ର୍ବ  ଅପେକ୍ଷା ଦୁ ର୍ବ ଳ ବି କ୍ଷେପ ଦେଖାଇବ ।

D.  କମ୍ପାସ ସୂ ଚୀ ପୂ ର୍ବ  ଅପେକ୍ଷା ଅଧି କ ବି କ୍ଷେପ ଦେଖାଇବ ।

✓

Q37 GA
କେଉଁ  ମସି ହାରେ ଭାରତ ଏହାର ପ୍ର ଥମ ICC କ୍ରି  କେଟ ବି ଶ୍ୱକପ୍  ଜି ତି ଥି ଲା?

A.  1975

B.  1983

C.  1992

D.  2003

✓

Q38 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତୀୟ କୃ ଷି ରେ ପ୍ର ଚ୍ଛନ୍ନ ବେକାରୀକୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ
ବ୍ୟାଖ୍ୟା କରି ଥାଏ?

A.  ଶ୍ର ମି କମାନେ କୃ ଷି  କାର୍ଯ୍ୟ ରେ ସମ୍ପୂ ର୍ଣ୍ଣ  ରୂ ପେ ଉତ୍ପାଦନକ୍ଷମ ହୋଇଥାନ୍ତି

B.  ଉତ୍ପାଦନ ପାଇଁ  ପ୍ର କୃ ତ ଆବଶ୍ୟକତାଠାରୁ  ଅଧି କ ଶ୍ର ମି କ ନି ୟୋଜି ତ ହୋଇଥାନ୍ତି

C.  ଗ୍ରା ମାଞ୍ଚଳରେ କୌଣସି  ଶ୍ର ମି କ ଉପଲବ୍ଧ ନୁ ହଁ ନ୍ତି  

D.  ସହରାଞ୍ଚଳ ତୁ ଳନାରେ ଶ୍ର ମି କମାନଙ୍କୁ  ଅଧି କ ମଜୁ ରୀ ପ୍ର ଦାନ କରାଯାଏ

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଏକ ଯୌଗି କ ନୁ ହେଁ ?

A.  ଆମୋନି ଆ (NH₃)

B.  ଅଙ୍ଗାରକାମ୍ଳ  (CO₂)

C.  ପି ତ୍ତଳ

D.  ମି ଥେନ (CH₄)

✓

Q40 GA
15ତମ ଶତାବ୍ଦୀରେ ଭାରତରେ ଗୁ ରୁ  ନାନକଙ୍କ ଦ୍ୱାରା କେଉଁ  ଧର୍ମ  ପ୍ର ତି ଷ୍ଠା କରାଯାଇଥି ଲା?

A.  ବୌଦ୍ଧ

B.  ଜୈ ନ ଧର୍ମ

C.  ଶି ଖ ଧର୍ମ

D.  ଯୋରାଷ୍ଟ୍ରୀୟ ଧର୍ମ
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English

✓

Q41 English

In the following question, choose the appropriate option which completes the sentence. If the
sentence is correct, choose ‘No article required’.

________ Indian Ocean has the warmest surface temperature in the world.
2251

A.  A

B.  An

C.  The

D.  No article required

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

A government by a few people

A.  Monarchy

B.  Oligarchy

C.  Democracy

D.  Plutocracy

✓

Q43 English
One of the following four sentences is in active voice. Select that sentence.

A.  Students are protesting against the fee hike.

B.  A new academic block is being constructed.

C.  History chapters have been revised.

D.  Spam phone calls should be blocked.

✓

Q44 English
Read the given sentence carefully. One word in the sentence is spelt incorrectly. Choose the option that has the same sentence with the correct
spelling of that word.

The geologist examined the peculiar crystel found deep inside the cave.

A.  The geologist examined the peculiar crystle found deep inside the cave.

B.  The geologist examined the peculiar crystal found deep inside the cave.

C.  The geologist examined the peculiar cristel found deep inside the cave.

D.  The geologist examined the peculiar crystaal found deep inside the cave.
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✓

Q45 English
Identify the sentence that is correctly written in the present tense.

A.  The committee finalized the proposal after several lengthy discussions.

B.  The committee had finalized the proposal before the meeting began.

C.  The committee will finalize the proposal after reviewing the report.

D.  The committee finalizes the proposal during its scheduled meetings.

✓

Q46 English
Choose the option that best replaces the highlighted words in the given sentence.

The children kept the doors locked while their parents were away, deciding that it is always better to be cautious than to regret a mistake
later.

A.  absence makes the heart grow fonder

B.  a stitch in time saves nine

C.  it is better to be safe than sorry

D.  better late than never

✓

Q47 English

Read the given passage and answer the questions that follow.

Apples are juicy, sweet, and tasty, and they are also an important part of a healthy diet. Research shows that eating apples can reduce the risk of
cancer, stroke, and heart disease. Studies at Cornell University and in Hawaii found nutrients in apples slow cancer cell growth and lower the risk
of lung cancer. Research in Finland showed men who ate apples had a lower risk of stroke, and at the University of California-Davis, apples
helped prevent harmful LDL cholesterol buildup, reducing heart attack risk.
Apples also aid digestion because they contain enzymes and fibre, particularly pectin, which lowers cholesterol. A medium apple has about 80
calories and 5 grams of fibre. Eating apples also cleans teeth and massages gums.
Apples are rich in phytochemicals, antioxidants, vitamins, and minerals like potassium and vitamin C. Phytochemicals reduce cell damage from
free radicals. Combined with other fruits, like oranges, apples improve nutrient absorption. Eating at least one apple a day supports overall
health.

Identify the central theme of the passage.

A.  Apples are nutritious and contribute to overall health.

B.  Apples are only a tasty snack with no health benefits.

C.  Fruits and vegetables are unnecessary for a healthy diet.

D.  Apple juice is more beneficial than whole apples.

✓

Q48 English
Why do apples work well with other fruits, like oranges?

A.  Apples make fruits less nutritious.

B.  Apples reduce the benefits of other fruits.

C.  Apples improve the body’s absorption of vitamin C from oranges.

D.  Apples increase the sugar content of oranges.
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✓

Q49 English
How can people use apples to support their health daily?

A.  Eat apples exclusively, ignoring other fruits and vegetables.

B.  Eat at least one apple a day as part of a balanced diet.

C.  Rely only on apple juice for nutrients.

D.  Avoid eating apples to prevent weight gain.

✓

Q50 English
Which of the following is the closest antonym for the word 'reduce'?

A.  Decrease

B.  Improve

C.  Increase

D.  Lessen

✓

Q51 English
Which of the following is true according to the passage?

A.  Eating apples can reduce the risk of cancer, stroke, and heart disease.

B.  Apples have no effect on cholesterol.

C.  Apples are high in fat and calories.

D.  Apples do not contain any vitamins or minerals.

✓

Q52 English
Find the antonym of the word given in bold:
Many students still revere their former English teacher.

A.  admire

B.  adore

C.  disrespect

D.  regard

✓

Q53 English
Select the correct option to complete the sentence with indirect speech.
The teacher said, “You must submit your assignments by Friday.”
The teacher told the students that they _______ their assignments by Friday.

A.  must submit

B.  have to submit

C.  had to submit

D.  will have to submit
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✓

Q54 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P= Release by 2050 but has not provided
Q= Or commercial availability details
R= A definitive development timeline
S= Kawasaki envisions a potential market

A.  SPRQ

B.  RQSP

C.  RQPS

D.  PSQR

✓

Q55 English

Replace the given word segment with the correct idiom.
Someone who argues against a point just to test its strength

A.  A backseat driver

B.  A fence sitter

C.  A devil's advocate

D.  A wet blanket

✓

Q56 English
Select the most appropriate antonym of the underlined word in the given sentence.

Attendance is mandatory for all students.

A.  obligatory

B.  accessory

C.  optional

D.  temporal

✓

Q57 English
In the given question, a statement divided into different segments is given. Rearrange all the segments to form a coherent statement.

the way you will/(O) the little things/(P) do the big things/(Q) the way you do/(R) says a lot about/(S)

A.  QPROS

B.  RPSOQ

C.  QRSPO

D.  SPOQR
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✓

Q58 English
Complete the sentence by choosing the correct option.
If he _____ the lottery, he would travel around the world.

A.  won

B.  appeared

C.  explored

D.  completed

✓

Q59 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Descriptions of what is going to happen to us based on the position of the stars and planets at the time of our birth often give us tips on how
to be better versions of ourselves, which can be helpful for our personal growth.

A.  Proverbs

B.  Myths

C.  Prognosis

D.  Horoscopes

✓

Q60 English
Select the most appropriate option to fill in the blank.

He was accused ______ cheating in the final exam.

A.  for

B.  with

C.  of

D.  about
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ____ କାମ କଲେ ସଫଳତା ଆସି ଥାଏ ।''

A.  ଧଯ୍ୟରେ

B.  ଧାର୍ଯ୍ୟ ରେ

C.  ଧୈ ର୍ଯ୍ୟ ରେ

D.  ଧର୍ଯ୍ୟ ରେ

✓

Q62 Odia
ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ବି ନ୍ଧ୍ୟ ପର୍ବ ତ କପି ଳାସଠାରୁ  ____ ଅଟେ ।''

A.  ଉଚ୍ଚତମ

B.  ଉଚ୍ଚତର

C.  ନୀଚ୍ଚତର

D.  ନୀଚ୍ଚତମ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ଏହି  ନଦୀଟି  ଖୁ ବ "ଦୀର୍ଘ " ଅଟେ।

A.  ଛୋଟ

B.  ଚାପଟ

C.  ନି ମ୍ନ

D.  ଖୁ ସି

✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଆର୍ଯ୍ୟ ଭଟ୍ଟ ଭାରତର ପ୍ର ଥମ ଉପଗ୍ର ହ ଅଟେ ।

A.  India’s first satellite is Aryabhata.

B.  India’s first rocket is Aryabhata.

C.  Aryabhata is India’s first astronaut.

D.  Aryabhata is India’s first space center.

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The Swachh Bharat Mission encourages people to maintain cleanliness in public areas.

A.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ ସାର୍ବ ଜନି କ ସ୍ଥଳରେ ସ୍ୱଚ୍ଛତା ରକ୍ଷା ପାଇଁ  ଜନତାମାନଙ୍କୁ  ପ୍ରୋ ତ୍ସାହନ କରେ।

B.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକମାନେ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ରଖି ବା ପ୍ରେ ରଣା ଦେଇ।

C.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକମାନଙ୍କ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ପ୍ରେ ରଣା ଦେଏ।

D.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ରଖି ବା ପ୍ରେ ରଣା ଦି ଏ।
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✓

Q66 Odia
"ତି ଳକୁ  ତାଳ କରି ବା"ର ଅର୍ଥ ?

A.  ଛୋଟ କଥାକୁ  ବଡ଼ କରି ବା

B.  ସଫଳତା

C.  ଭୟଭୀତ ହେବା

D.  ଲୁ ଚାଇବା

✓

Q67 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରଜନୀ 20 ବର୍ଷ  ହେଲାଣି  ଆମ ଘରେ କାମ କରି ଆସୁ ଛି  ।

A.  Rajni is working in our house for 20 years.

B.  Rajni had been working in our house for 20 years.

C.  Rajni has been working in our house for 20 years.

D.  Rajni will work in our house for 20 years.

✓

Q68 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

2025 ମସି ହାରେ ପାଳି ତ ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲଙ୍କ 150 ତମ ଜନ୍ମ ବାର୍ଷିକୀ ଭାରତର ଜଣେ ମହାନ ରାଷ୍ଟ୍ର ନି ର୍ମା ତା ଏବଂ ଜାତୀୟ ଏକତାର ସ୍ଥପତି ଙ୍କୁ  ସମ୍ମାନି ତ କରି ବାରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ
ମାଇଲଖୁ ଣ୍ଟ। ସର୍ଦ୍ଦା ର ପଟେଲ 1875 ମସି ହାର 31 ଅକ୍ଟୋବରରେ ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ | ଭାରତର ସ୍ୱାଧୀନତା ଆନ୍ଦୋଳନ ସମୟରେ ତାଙ୍କର ଅସାଧାରଣ ନେତୃ ତ୍ୱ ଏବଂ 560 ରୁ  ଅଧି କ ଗଡ଼ଜାତ
ରାଜ୍ୟକୁ  ଭାରତୀୟ ସଂଘରେ ଏକୀକୃ ତ କରି ବାରେ ତାଙ୍କର ପ୍ର ମୁ ଖ ଭୂ ମି କା ପାଇଁ  ସେ ଚି ରସ୍ମରଣୀୟ । ତାଙ୍କର ଦୃ ଢ଼ ଇଚ୍ଛାଶକ୍ତି , ପ୍ର ଶାସନି କ ବୁ ଦ୍ଧି ମତା ଏବଂ ନି ର୍ଭୀ କ ଦେଶପ୍ରେ ମ ତାଙ୍କୁ  "ଭାରତର ଲୌହ
ପୁ ରୁ ଷ" ଉପାଧି  ପ୍ର ଦାନ କରି ଥି ଲା। 150 ତମ ବାର୍ଷିକୀ ପାଳନ ଏକ ସଂଯୁ କ୍ତ, ଗଣତାନ୍ତ୍ରି କ ଭାରତର ମୂ ଳଦୁ ଆ ସ୍ଥାପନ କରି ବାରେ ତାଙ୍କ ଅବଦାନକୁ  ମନେ ପକାଇବା ପାଇଁ  ଜାତୀୟ ପ୍ର ତି ଫଳନର ଏକ
ମୁ ହୂ ର୍ତ୍ତ । ଦେଶବ୍ୟାପୀ ବର୍ଷ ସାରା, ବି ଭି ନ୍ନ କାର୍ଯ୍ୟ କ୍ର ମ ରେ ତାଙ୍କର ରାଷ୍ଟ୍ରନୀତି , ଜାତୀୟ ସଂହତି  ପ୍ର ତି  ପ୍ର ତି ବଦ୍ଧତା ଏବଂ ଦୃ ଢ଼ ଶାସନ ପାଇଁ  ଦୃ ଷ୍ଟି କୋଣକୁ  ପ୍ର ଦର୍ଶିତ କରାଯାଉଛି  । ଶି କ୍ଷାନୁ ଷ୍ଠାନ, ସରକାରୀ
ସଂସ୍ଥା, ନାଗରି କ ସଂଗଠନ ଏବଂ ଯୁ ବ ଗୋଷ୍ଠୀ ପଟେଲଙ୍କ ଶୃ ଙ୍ଖଳା, ଏକତା ଏବଂ ଜନସେବାର ଆଦର୍ଶ କୁ  ପୁ ନଃ ଆବି ଷ୍କାର କରି ବା ପାଇଁ  ସେମି ନାର, ପ୍ର ଦର୍ଶ ନୀ, ବି ତର୍କ  ଏବଂ ସାଂସ୍କୃତି କ କାର୍ଯ୍ୟ କ୍ର ମ
ମାନର ଆୟୋଜନ କରନ୍ତି । ଏହି  ଅବସରରେ ଭବି ଷ୍ୟତ ପି ଢ଼ି କୁ  ତାଙ୍କର ଅଖଣ୍ଡତା, ସାହସ ଏବଂ ଦେଶ-ପ୍ର ଥମେ ଚି ନ୍ତାଧାରାର ମୂ ଲ୍ୟବୋଧକୁ  ଅନୁ କରଣ କରି ବା ପାଇଁ  ପ୍ରେ ରଣା ଦେବା ଉପରେ ବି ଶେଷ
ଗୁ ରୁ ତ୍ୱ ଦି ଆଯାଊଛି ।

ଏହି  ଉତ୍ସବ ପାଳନ ର ଏକ ପ୍ର ମୁ ଖ କେନ୍ଦ୍ରବି ନ୍ଦୁ  ହେଉଛି  ଗୁ ଜରାଟରେ ବି ଶ୍ୱର ସର୍ବୋ ଚ୍ଚ ପ୍ର ତି ମୂ ର୍ତ୍ତି ଷ୍ଟାଚ୍ୟୁ  ଅଫ୍  ୟୁ ନି ଟି , ଯାହା ଭାରତର ଏକତା ଏବଂ ସାମୂ ହି କ ଗର୍ବ ର ପ୍ର ତୀକ ଭାବରେ ସର୍ଦ୍ଦା ର
ପଟେଲଙ୍କ ପ୍ର ତି  ଉତ୍ସର୍ଗୀ କୃ ତ। ଏହି  ଅବସରରେ, ଜାତୀୟ ସୁ ରକ୍ଷା, ସୁ ଶାସନ ଏବଂ ଗ୍ରା ମୀଣ ବି କାଶ ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରୁ ଥି ବା କାର୍ଯ୍ୟ କ୍ର ମ ଗୁ ଡ଼ି କ ପଟେଲଙ୍କ ଏକ ଶକ୍ତି ଶାଳୀ, ଆତ୍ମନି ର୍ଭ ରଶୀଳ
ଏବଂ ସମନ୍ୱି  ତ ଭାରତର ବାର୍ତ୍ତା କୁ  ଆହୁ ରି  ଦୃ ଢ଼ କରି ଥାଏ। ରନ ଫର୍  ୟୁ ନି ଟି , ଜନସଚେତନତା ଅଭି ଯାନ, ପ୍ର ବନ୍ଧ ପ୍ର ତି ଯୋଗି ତା ଏବଂ ଡକ୍ୟୁ ମେଣ୍ଟାରୀ ଭଳି  କାର୍ଯ୍ୟ କଳାପ ତାଙ୍କର ଦୂ ରଦୃ ଷ୍ଟି ପୂ ର୍ଣ୍ଣ
ଅବଦାନକୁ  ଉଜ୍ଜ୍ୱଳ କରି ଥାଏ, ଯେଉଁ ଥି ରେ ଅଖି ଳ ଭାରତୀୟ ନାଗରି କ ସେବା ସୃ ଷ୍ଟି , କୃ ଷି  ସଂସ୍କାର ଏବଂ ସମବାୟ ଆନ୍ଦୋଳନର ପ୍ରୋ ତ୍ସାହନ ଅନ୍ତର୍ଭୁ କ୍ତ। 150ତମ ବାର୍ଷିକୀ କେବଳ ତାଙ୍କ ଐତି ହ୍ୟ
ପ୍ର ତି  ଶ୍ର ଦ୍ଧାଞ୍ଜଳି  ନୁ ହେଁ  ବରଂ ଏକ ସ୍ମରଣକାରୀ ଯେ ବି ବି ଧତାରେ ଏକତା ଏବଂ ନି ର୍ଣ୍ଣା ୟକ ନେତୃ ତ୍ୱ ଭାରତର ନି ରନ୍ତର ସଫଳତା ଏବଂ ପ୍ର ଗତି  ପାଇଁ  ଅପରି ହାର୍ଯ୍ୟ  ରହି ଛି । ଭାରତ ଏହି  ଐତି ହାସି କ ବର୍ଷ କୁ
ସ୍ମରଣ କରୁ ଥି ବା ସମୟରେ, ସର୍ଦ୍ଦା ର ପଟେଲଙ୍କ ଜୀବନ ସାମୂ ହି କ ଦାୟି ତ୍ୱ, ଦେଶପ୍ରେ ମ ଏବଂ ଜାତୀୟ ସଂହତି  ପ୍ର ତି  ଅଟଳ ସମର୍ପ ଣକୁ  ପ୍ରେ ରଣା ଦେଇ ଚାଲି ଛି ।

ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲ କେବେ ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ?

A.  1857

B.  1875

C.  1885

D.  1890

✓

Q69 Odia
ସର୍ଦ୍ଦା ର ପଟେଲ କେଉଁ  ନାମରେ ବେଶ ଲୋକପପ୍ରି  ୟ?

A.  ସମ୍ବି ଧାନର ଜନକ

B.  ଭାରତର ଲୌହ ପୁ ରୁ ଷ

C.  ଭାରତର କ୍ଷେପଣାସ୍ତ୍ର ପୁ ରୁ ଷ

D.  ସୀମାନ୍ତ ଗାନ୍ଧୀ
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✓

Q70 Odia
2025 ମସି ହାରେ ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲଙ୍କ କେଉଁ  ଜନ୍ମ ବାର୍ଷିକୀ ପାଳି ତ ହୋଇଛି ?

A.  150 ତମ

B.  140 ତମ

C.  151 ତମ

D.  145 ତମ

✓

Q71 Odia
ଷ୍ଟାଚ୍ୟୁ  ଅଫ୍  ୟୁ ନି ଟି  ର ପ୍ର ତି ମୂ ର୍ତ୍ତି କାହାକୁ  ଉତ୍ସର୍ଗୀ କୃ ତ କରାଯାଇଛି ?

A.  ମହାତ୍ମା ଗାନ୍ଧୀ

B.  ଜବାହରଲାଲ ନେହେରୁ

C.  ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲ

D.  ସୁ ଭାଷ ଚନ୍ଦ୍ର ବୋଷ

✓

Q72 Odia
ସର୍ଦ୍ଦା ର ପଟେଲଙ୍କ ପ୍ର ମୁ ଖ ଅବଦାନ କଣ ଥି ଲା?

A.  ବୈ ଦେଶି କ ନୀତି

B.  ଜାତୀୟ ସଂହତି  ଏବଂ ନାଗରି କ ସେବା

C.  ମହାକାଶ ଗବେଷଣା

D.  ବାଣି ଜ୍ୟ ସଂସ୍କାର

✓

Q73 Odia
କେଉଁ ଟି  ତତ୍ସମ ଶବ୍ଦ ଚି ହ୍ନଟ କର ?

A.  ନେତ

B.  ଅନନ୍ତ

C.  ମୁ ଗ

D.  ବି ରି

✓

Q74 Odia
ଗୋବି ନ୍ଦବାବୁ  ଶ୍ୟାମକୁ  ଘରକୁ  ଡାକି ଲେ - ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  କ୍ରି  ୟାପଦ ଚି ହ୍ନଟ କର ।

A.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

B.  ସକର୍ମ କ କ୍ରି  ୟା

C.  ଅକର୍ମ କ କ୍ରି  ୟା

D.  ଅମି ଶ୍ର  କ୍ରି  ୟା

✓

Q75 Odia
ନି ମ୍ନୋ କ୍ତ ଶବ୍ଦଗୁ ଡି କ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନଟ କର ?

A.  ଗଧ

B.  ହସ୍ତୀ

C.  ଗର୍ଦ୍ଦ ଭ

D.  ମର୍କ ଟ
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Computer

✓

Q76 Computer
Which tab in MS Word 2021 contains the Bullets and Numbering
options?

A.  Insert

B.  Layout

C.  Home

D.  References

✓

Q77 Computer
Which of the following best defines E-Commerce?

A.  Sharing messages and photos on social media

B.  Buying and selling goods or services using the Internet

C.  Playing online games with friends

D.  Sending emails to friends and teachers

✓

Q78 Computer
What is the right option to insert a video from your computer into a
slide?

A.  Insert → Audio → This Device

B.  Insert → Video → This Device

C.  Home → Insert Video

D.  Slide Show → Media

✓

Q79 Computer
If a user edits the Slide Master in a MS PowerPoint file that was
created using a company template, what happens?

A.  The original template is permanently changed.

B.  Changes affect only the current presentation.

C.  All PowerPoint templates update automatically.

D.  Slide Master editing is not allowed.

✓

Q80 Computer
ଏକ୍ସେଲର କେଉଁ  ଫି ଚର ଆପଣଙ୍କୁ  ସେଲ୍  (cells)ଗୁ ଡି କରେ "ଜାନୁ ଆରୀ, ଫେବୃ ଆରୀ, ମାର୍ଚ୍ଚ "
ଭଳି  ଏକ ସି ରି ଜକୁ  ଅଟୋମେଟି କ ଭାବେ ପୂ ରଣ କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦି ଏ?

A.  AutoCorrect

B.  Fill Handle

C.  Quick Analysis

D.  Data Validation

✓

Q81 Computer
ମୋଜି ଲା ୱେବ ବ୍ରା ଉଜର ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବର୍ଗ ରେ ଆସି ଥାଏ?

A.  ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେର

B.  ସି ଷ୍ଟମ ସଫ୍ଟ ୱେର

C.  ଡି ଭାଇସ ଡ୍ରା ଇଭର

D.  ସି ଷ୍ଟମ ୟୁ ଟି ଲି ଟି ଜ

✓

Q82 Computer
__________ is considered as an example of System Software.

A.  Operating System

B.  Microsoft Word

C.  Google Chrome

D.  Adobe Photoshop

✓

Q83 Computer
MS ପାୱାରପଏଣ୍ଟ 2007 ରେ ସ୍ଲା ଇଡଶୋରୁ  ବାହାରି ବା ପାଇଁ  କେଉଁ  କି  ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  ESC କୀ

B.  F3 କୀ

C.  F7 କୀ

D.  F8 କୀ

✓

Q84 Computer
Which of the following is NOT a print option in MS Word?

A.  Print Custom Range

B.  Print Current Slide

C.  Print Selection

D.  Print All Pages
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✓

Q85 Computer
କମ୍ପ୍ୟୁ ଟର କମ୍ପୋନେଣ୍ଟ ବି ଷୟରେ ନି ମ୍ନ ଲି ଖି ତ ବି ବୃ ତି ଗୁ ଡ଼ି କୁ  ବି ଚାର କର ।

(1) RAM ଅସ୍ଥାୟୀ ଭାବରେ ଡାଟା ଷ୍ଟୋର କରେ ଏବଂ ଯେତେବେଳେ କମ୍ପ୍ୟୁ ଟର ବନ୍ଦ ହୁ ଏ
ସେତେବେଳେ ଏହା ଇରେଜ (erased) ହୋଇଯାଏ ।
(2) ପାୱାର ଲଷ୍ଟ ହେଲେ ମଧ୍ୟ ROM ଡାଟା ରି ଟେନ କରି ଥାଏ (retains) ଏବଂ ଏଥି ରେ
ଷ୍ଟାର୍ଟ ଅପ ଇନଷ୍ଟ୍ରକସନ ଥାଏ ।
(3) ହି ସାବ କରି ବା ଏବଂ ନି ଷ୍ପତ୍ତି  ନେବା (calculations and decision-making) ପାଇଁ
CPU ଦାୟୀ ଅଟେ ।
(4) PCB ଏକ ସଫ୍ଟ ୱେର ଅଟେ ଯାହା ଇଲେକ୍ଟ୍ରୋନି କ ସର୍କିଟ ସି ମୁ ଲେଟ କରି ବା ପାଇଁ
ବ୍ୟବହୃ ତ ହୁ ଏ ।

ନି ମ୍ନ ଲି ଖି ତ ଅପସନଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସଠି କ?

A.  କେବଳ 1, 2 ଓ 3 ସଠି କ ଅଟେ

B.  କେବଳ 1 ଓ 4 ସଠି କ ଅଟେ

C.  କେବଳ 2 ଓ 3 ସଠି କ ଅଟେ

D.  କେବଳ 1, 3 ଓ 4 ସଠି କ ଅଟେ

✓

Q86 Computer
ଏକ୍ସେଲ ଫର୍ମୁ ଲା ରେ ଗୁ ଣନ ପାଇଁ  କେଉଁ  ସି ମ୍ବଲ ବ୍ୟବହାର କରାଯାଏ?

A.  X

B.  *

C.  &

D.  #

✓

Q87 Computer
In the abbreviation CPU, what does the letter 'P' stand for?

A.  Power

B.  Processing

C.  Program

D.  Protocol

✓

Q88 Computer
ମାଇକ୍ରୋ ସଫ୍ଟ  ଏକ୍ସେଲ ଲଞ୍ଚ କରି ବା ପାଇଁ  ରନ ଡାଏଲଗରେ ଏଣ୍ଟର କରି ବାକୁ  ପଡି ବ ବୋଲି
କମାଣ୍ଡ ଚୟନ କର ।

A.  calc

B.  excel

C.  .xls

D.  spreadsheet

✓

Q89 Computer
Which device connects computers in a LAN?

A.  Monitor

B.  Router

C.  Printer

D.  Keyboard

✓

Q90 Computer
What happens when you click File → New in MS Word?

A.  It opens an existing document.

B.  It creates a blank document or opens a template.

C.  It closes the application.

D.  It saves the document.
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Reasoning

✓

Q91 Reasoning
A ହେଉଛି  F ର ଭାଇ । B ହେଉଛି  A ର ଭଉଣୀ । D ହେଉଛି  B ର ପୁ ଅ । C ହେଉଛି  D ର
ଭଉଣୀ । E ହେଉଛି  D ର ପୁ ଅ । ତେବେ A କି ପରି  C ସହି ତ ସମ୍ପର୍କିତ?

A.  ମାଆଙ୍କ ଭାଇ

B.  ମାଆଙ୍କ ବାପା

C.  ମାଆଙ୍କ ମାଆ

D.  ବାପାଙ୍କ ବାପା

✓

Q92 Reasoning
ସାତଟି  ବାକ୍ସ A, B, C, L, E, Y ଏବଂ G କୁ  ଗୋଟି ଏ ଉପରେ ଅନ୍ୟଟି  ରଖାଯାଇଛି  କି ନ୍ତୁ
ସମାନ କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  । G ତଳେ କେବଳ ଗୋଟି ଏ ବାକ୍ସ ରଖାଯାଇଛି  । A
ଏବଂ G ମଧ୍ୟରେ କେବଳ ଦୁ ଇଟି  ବାକ୍ସ ରଖାଯାଇଛି  । B ଉପରେ Y କୁ  ରଖାଯାଇଛି  । L
ଉପରେ କି ନ୍ତୁ A ତଳେ C କୁ  ରଖାଯାଇଛି  । L ଉପରେ E କୁ  ରଖାଯାଇ ନାହିଁ । କେଉଁ  ବାକ୍ସକୁ
ଶୀର୍ଷ ରୁ  ଚତୁ ର୍ଥ  ସ୍ଥାନରେ ରଖାଯାଇଛି ?

A.  Y

B.  C

C.  B

D.  L

✓

Q93 Reasoning
ଯଦି  '+' ଏବଂ '–' କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ଏବଂ '×' ଏବଂ '÷' କୁ
ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?)
ସ୍ଥାନରେ କ'ଣ ଆସି ବ?
25 × 5 – 12 ÷ 2 + 11 = ?

A.  18

B.  29

C.  34

D.  45

✓

Q94 Reasoning
HR 21 is related to KT 7 in a certain way. In the same way, NM 28 is
related to QO 14. To which of the following is IE 24 related, following
the same logic?

A.  LG 10

B.  KJ 11

C.  LK 19

D.  JH 25

✓

Q95 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମରେ ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ହେବ?
GOM IMP KKS MIV ?

A.  OGY

B.  JHU

C.  POI

D.  NHY

✓

Q96 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ 'PAMS' କୁ  '5238' ଭାବରେ ଏବଂ 'MARS' କୁ  '3982'
ଭାବରେ କୋଡ କରାଯାଇଛି  । ପ୍ର ଦତ୍ତ କୋଡ ଭାଷାରେ 'R' ପାଇଁ  କୋଡ କ'ଣ ହେବ?

A.  3

B.  9

C.  8

D.  2

✓

Q97 Reasoning
P, Q, R, S, T, U ଓ V ଉତ୍ତର ଦି ଗକୁ  ମୁ ହଁ  କରି  ଏକ ସି ଧା ଧାଡି ରେ ବସି ଛନ୍ତି  । U ଙ୍କ ବାମ
ପାର୍ଶ୍ୱ ରେ କେବଳ V ବସି ଛି  । V ଓ Q ଙ୍କ ମଧ୍ୟରେ କେବଳ ଚାରି  ଜଣ ଲୋକ ବସି ଛନ୍ତି  । T ଓ
P ଙ୍କ ମଧ୍ୟରେ କେବଳ S ବସି ଛି  ଏବଂ Q ର ନି କଟତମ ପଡ଼ୋଶୀ T ନୁ ହେଁ  । ଧାଡି ର ଡାହାଣ
ପ୍ରା ନ୍ତରେ କି ଏ ବସି ଛି ?

A.  P

B.  R

C.  T

D.  U

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ
ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି  ସେହି
ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ  ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  KFI

B.  MHL

C.  OJN

D.  QLP
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✓

Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statements:
Some chairs are rabbits.
Some rabbits are games.

Conclusions (I) : Some chairs are games.
Conclusions (II) : All games are rabbits.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ
କରାଯି ବ । (ଟି ପ୍ପଣୀ: ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ ଅଙ୍କ ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ)
(ବାମ) 1 2 3 3 5 4 8 9 7 1 6 5 7 5 9 8 7 5 1 2 3 5 9 8 7 9 2 1 (ଡାହାଣ)
ଏପରି  କେତେଟି  ଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ପୂ ର୍ଣ୍ଣ ବର୍ଗ  ଏବଂ ଠି କ
ପରେ ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି ?
(ଟି ପ୍ପଣୀ: 1 ମଧ୍ୟ ଏକ ପୂ ର୍ଣ୍ଣ ବର୍ଗ  ଅଟେ)

A.  ସାତ

B.  ଛଅ

C.  ପାଞ୍ଚ

D.  ଚାରି
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